
Chapter 12

Plotting Drawings

After completing this chapter, you will be able to:
• Set plotter specifications and plot drawings.
• Configure plotters and then edit plotter configuration files.
• Create, use, and modify plot styles and plot style tables.

Learning Objectives
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PLOTTING DRAWINGS IN AutoCAD LT
After you have completed a drawing, you can store it on the computer storage device such as the
hard drive or diskette. However, to get its hard copy, you should plot the drawing on a sheet of
paper using a plotter or printer. A hard copy is a handy reference for professionals working on
site. With pen plotters, you can obtain a high-resolution drawing. Basic plotting has already
been discussed in Chapter 2, Getting Started with AutoCAD LT. You can plot drawings in the
Model tab or any of the layout tabs. A drawing has a Model and two layout tabs (Layout 1,
Layout 2) by default. Each of these tabs has its own settings and can be used to create different
plots. You can also create new layout tabs using the LAYOUT command. This is discussed in
Chapter 11.

PLOTTING DRAWINGS USING THE PLOT DIALOG BOX

The PLOT command is used to plot a drawing. When you invoke this command, the
Plot dialog box is displayed. You can also right-click on the Model tab or any of the
layout tabs to display the shortcut menu and choose Plot to invoke the Plot dialog box.

Figure 12-1 shows the expanded form of the Plot dialog box.

Toolbar: Standard > Plot
Menu: File > Plot
Command: PLOT

Figure 12-1  Expanded form of the Plot dialog box
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Some values in this dialog box were set when AutoCAD LT was first configured. You can examine
these values and if they conform to your requirements, you can start plotting directly. You can
alter plot specifications, through the options in the Plot dialog box. The available plot options
are described next.

Page setup Area
The Name drop-down list in this area displays all the saved and named page setups. A page
setup contains the settings required to plot a drawing on a sheet of paper to create a layout. It
consists of all the settings related to the plotting of a drawing such as the scale, pen settings, and
so on, and also includes the plot devices being used. These settings can be saved as a named
page setup, which can be later selected from this drop-down list and used for plotting a drawing.
If you select Previous plot from the drop-down
list, the settings used for the last drawing plotted
are applied to the current drawing. You can choose
the base for the current page setup on a named
page setup, or you can add a new named page
setup by choosing the Add button, which is located
next to the drop-down list. When you choose this
button, AutoCAD LT displays the Add Page Setup
dialog box, as shown in Figure 12-2.

Enter the name of the new page setup in this dialog box and choose OK. All the settings that
you configure in the current Plot dialog box will be saved under this page setup.

Tip
Select an existing page setup from the Name drop-down list and make modifications in it and
then choose the Add button to create a new page setup based on an existing one.

Printer/plotter Area
This area displays all the information about the configured printers and plotters currently selected
from the Name drop-down list. It displays the plotter driver and the printer port being used. It
also displays the physical location and some description text about the selected plotter or printer.
All the currently configured plotters are displayed in the Name drop-down list.

Note
To add plotters and printers to the Name drop-down list, choose Plotter Manager from the File
menu to display the Plotters window. Double-click on the Add-A-Plotter Wizard icon in this
window to display the Add Plotter wizard. You can use this wizard to add a plotter to the list of
configured plotters. Also, plotter configuration file (PC3) for the plotter is created. This file
consists of all the settings needed by the specific plotter to be plotted. The Plotters window will
be discussed later in this chapter in the section PLOTTERMANAGER Command.

Properties
To check information about a configured printer or plotter, choose the Properties button.
When you choose this button, the Plotter Configuration Editor is displayed. This dialog box

Figure 12-2  The Add Page Setup dialog box
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lists all the details of the selected plotter under three tabs: General, Ports, and Device and
Document Settings. The Plotter Configuration Editor will be discussed later in the “Editing
Plotter Configuration” section of this chapter.

Plot to file
If you select this check box, AutoCAD LT plots the output to a file rather than to the plotter.
Depending on the plotter selected, the file can be plotted in the .dwf, .plt, .jpg, or .png format.
The file name and its location can be specified using the Browse for Plot File dialog box, which
is displayed when you choose OK from the Plot dialog box, after selecting this check box.

Partial Preview Window
The window displayed below the Properties button is called the Partial Preview window. The
preview in this window dynamically changes as you modify the parameters in the Plot dialog
box. The outer rectangle in this window is the paper you selected. It also shows the size of the
paper. The inner hatched rectangle is the section of the paper that is used by the image. If the
image extends beyond the paper, a red border is displayed around the paper.

Paper size Area
The drop-down list in this area displays all the standard paper sizes for the selected plotting
device. You can select any size from the list to make it current. If None has been selected
currently from the Name drop-down list in the Printer/plotter area, AutoCAD LT will display
the list of all the standard paper sizes.

Number of copies Area
You can use the spinner available in this area to specify the number of copies that you want to
plot. If multiple layouts and copies are selected and some of the layouts are set for plotting to a
file or AutoSpool, they will produce a single plot. AutoSpool allows you to send a file for
plotting while you are working on another program.

Plot area Area
Using the What to plot drop-down list provided in this area, you can specify the portion of the
drawing to be plotted. You can also control the way the plotting will be carried out. The options
in the What to plot drop-down list are described next.

Display
If you select this option, the portion of the drawing that is currently being displayed on the
screen is plotted.

Extents
This option resembles the Extents option of the ZOOM command and prints the drawing to
the extents of the objects. If you add more objects to the drawing, they are also included in the
plot and the extents of the drawing are recalculated. If you reduce the drawing extents by
erasing, moving, or scaling the objects, the extents of the drawing are again recalculated. You
can use the Extents option of the ZOOM command to determine which objects shall be plotted.
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If you use the Extents option when the perspective view is on and the position of the camera is
not outside the drawing extents, the following message is displayed: Plot of perspective view
has been scaled to fit available area.

Limits
This option is available only if you plot from the Model tab. Selecting this option plots the
complete area defined within the drawing limits.

Note
To be able to clearly view the differences between the three previously listed plotting options, it
may be a good idea to make sure that the default scale options have been selected. If not, select the
Fit to paper check box from the Plot scale area of the dialog box if you are in the Model tab, and
select 1:1 if you are working in any one of the layout tabs.

Window
With this option, you can specify the section of the drawing to be plotted by defining a window.
The section of the drawing contained within the window defined by selecting a lower left corner
and an upper right corner is plotted. To define a window, select the Window option from the
What to plot drop-down list. The Plot dialog box will be temporarily closed and you will be
prompted to specify two points on the screen that define a window, the area within which shall
be plotted. Once you have defined the window, the Plot dialog box is redisplayed on the screen.
You will notice that the Window button is displayed on the right of the What to plot drop-down
list now. To reselect the area to be plotted, choose the Window button. You will notice that the
previously selected area is displayed in white and the remaining area is displayed in gray. After
selecting the area to be plotted, you can choose the OK button in the dialog box to plot the
drawing.

Note
Sometimes, when using the Window option, the area you have selected may appear clipped off.
This may happen because the objects are too close to the window you have defined on the screen.
You need to redefine the window in this situation. Such errors can be avoided by using the
preview options discussed later.

View
Selecting the View option enables you to plot a view that was created with the VIEW command.
The view must be defined in the current drawing. If no view has been created, the View option
is not displayed. When you select this option, a drop-down list is displayed in this area. You
can select a view for plotting from this drop-down list and then choose OK in the Plot dialog
box. When using the View option, the specifications of the plot will depend on the specifications
of the named view.

Layout
This option is available only when you are plotting from the layout. This option prints the entire
content of the drawing that lies inside the printable area of the paper selected from the drop-down
list in the Paper size area.
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Plot offset (origin set to printable area) Area
This area allows you to specify an offset of the plotting area from the lower left corner of the
paper. The lower left corner of a specified plot area is positioned at the lower left margin of the
paper by default. If you select the Center the plot check box, AutoCAD LT automatically centers
the plot on the paper by calculating the X and Y offset values. You can specify an offset from the
origin by entering positive or negative values in the X and Y edit boxes. For example, if you
want the drawing to be plotted 4 units to the right and 4 units above the origin point, enter 4 in
both the X and Y edit boxes. Depending on the units you have specified in the Paper size and
paper units area of the dialog box, the offset values are either in inches or in millimeters.

Plot scale Area
This area controls the drawing scale of the plot area. The Scale drop-down list has thirty-one
architectural and decimal scales apart from Custom option. The default scale setting is 1:1 when
you are plotting a layout. However, if you are plotting in a Model tab, the Fit to paper check box
is selected. The Fit to paper option allows you to automatically fit the entire drawing on the
paper. It is useful when you have to print a large drawing using a printer that uses a smaller size
paper or when you want to plot the drawing on a small sheet.

Whenever you select a standard scale from the drop-down list, the scale is displayed in the edit
boxes as a ratio of the plotted units to the drawing units. You can also change the scale factor
manually in these edit boxes. When you do so, the Scale edit box displays Custom. For example,
for an architectural drawing, which is to be plotted at the scale 1/4"=1'-0", you can enter either
1/4"=1'-0" or 1=48 in the edit boxes.

Note
The PSLTSCALE system variable controls the paper space linetype scaling and has a default
value of 1. This implies that irrespective of the zoom scale of the viewports, the linetype scale of
the objects in the viewports remains the same. If you want the linetype scale of the objects in
different viewports with different magnification factors to appear different, you should set the
value of the PSLTSCALE variable to 0. This has been discussed in detail in Chapter 11 (Model
Space Viewports, Paper Space Viewports, and Layouts).

The Scale lineweights check box is available only if you are plotting in a layout tab. This option
is not available in the Model tab. If you select the Scale lineweights check box, you can scale
lineweights in proportion to the plot scale. Lineweights generally specify the linewidth of the
printable objects and are plotted with the original lineweight size, regardless of the plot scale.

Note
You can save your custom scales that you use during plotting or in layouts in the Edit Scale List
dialog box. Select the Scale List option from the Format option of the menu bar to invoke the
Edit Scale List dialog box. The Scale List area lists the default scales available in the
AutoCAD LT. Choose the Add Scale button to invoke the Add Scale dialog box. Enter the name
for the custom scale in the Name appearing in the scale list area edit box. This name will
appear in the Scale List area. Enter the scale in the Scale Properties area, and choose the Ok
button. The name is now listed in the Scale List area. Like this, you can keep a track of the
custom scales used.
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Plot style table (pen assignments) Area
This area in the Plot dialog box allows you to view and select a plot style table, edit the current
plot style table, or create a new plot style table. A plot style table is a collection of plot styles. A
plot style is a group of pen settings that are assigned to an object or layer and that determine the
color, thickness, line ending, and the fill style of drawing objects when they are plotted. It is a
named file that allows you to control the  pen settings for a plotted drawing.

You can select the required plot style from the drop-down list in this area. Whenever you select
a plot style, AutoCAD LT displays the Question box asking you to specify whether or not the
selected plot style should be assigned to all the layouts. If you choose Yes, the selected plot style
will be used to plot from all the layouts. You can also select None from the drop-down list to plot
a drawing without using any plot styles. You can assign different plot style tables to a drawing
and plot the same drawing differently each time. The use of plot styles will be discussed later in
this chapter.

You can also select New from the drop-down list to create a new plot style. When you select this
option, a wizard will be started that will guide you through the process of creating a new plot
style.

Note
You will learn more about creating plot styles later in this chapter.

Edit
You can edit a plot style table you have selected from the Name drop-down list by choosing the
Edit button. This button is not available when you have selected None from the drop-down list.
When you choose the Edit button, AutoCAD LT displays the Plot Style Table Editor, where you
can edit the selected plot style table. This dialog box has three tabs: General, Table View, and
Form View. The Plot Style Table Editor will be discussed later in the “Using Plot Styles”
section of this chapter.

Shaded viewport options Area
The options in this area are used to print a shaded or a rendered image. These options are
discussed next.

Shade plot
This drop-down list is used to select a technique that will be used to plot the drawings. If you
select As displayed from this drop-down list, the drawing will be plotted as it is displayed on
the screen. If the drawing is hidden, shaded, or rendered, it will be printed as it is.
The hidden geometry consists of objects that lie behind the facing geometry and displays the
object as it would be seen in reality. If you select the Wireframe option, the model will be
printed in wireframe displaying all the hidden geometries, even if it is shaded in the
drawing. Selecting the Hidden option plots the drawing with the hidden lines suppressed.
Similarly, selecting the Rendered option plots the rendered image of the drawing.
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Quality
This drop-down list is used to select printing quality in terms of dots per inch (dpi) for the
printed drawing. The Draft option prints the drawing with 0 dpi, which results in the wireframe
printout. The Preview option prints the drawing at 150 dpi, the Normal option prints the
drawing at 300 dpi, the Presentation option prints the drawing at 600 dpi, the Maximum
option prints the drawing at the selected plotting device’s maximum dpi. You can also specify a
custom dpi by selecting the Custom option from this drop-down list. The custom value of dpi
can be specified in the DPI drop-down list, which is enabled below the Quality drop-down list
when you select the Custom option.

Note
Selecting the Draft option from the Quality drop-down list prints the drawing in wireframe
even if you select Rendered from the Shade plot drop-down list. Also, to plot the drawings in
layouts with the hidden lines suppressed, you need to use the Shade Plot option discussed in
Chapter 11, Model Space Viewports, Paper Space Viewports, and Layouts.

You will learn more about wireframe, hidden, shaded, and rendered models in later chapters.

Plot options Area
This area displays six options that can be selected as per the plot requirements. They are described
next.

Plot object lineweights
This check box is not available if the Plot with plot styles check box is selected. To activate this
option, clear the Plot with plot styles check box. This check box is selected by default and
AutoCAD LT plots the drawing with the specified lineweights. To plot the drawing without the
specified lineweights, clear this check box.

Plot with plot styles
When you select the Plot with plot styles check box, AutoCAD LT plots using the plot styles
applied to the objects in the drawing and defined in the plot style table. The different property
characteristics associated with the different style definitions are stored in the plot style tables
and can be easily attached to the geometry. This setting replaces the pen mapping used in
earlier versions of AutoCAD LT.

Plot paperspace last
This check box is not available when you are in the Model tab because no paper space objects
are present in the Model tab. This option is available when you are working in a layout tab. By
selecting the Plot paperspace last check box, you get an option of plotting model space geometry
before paper space objects. Usually the paper space geometry is plotted the before model space
geometry. This option is also useful when there are multiple tabs selected for plotting and you
want to plot the model space geometry before the layout tabs.
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Hide paperspace objects
This check box is used to specify whether or not the objects drawn in the layouts will be hidden
while plotting. If this check box is selected, the objects created in the layouts will be hidden.

Plot stamp on
This check box is selected to turn the plot stamp on. The plot stamp is a user-defined information
that will be displayed on the sheet after plotting. You can set the plot stamping when you select
this check box. When you select this check box, the Plot Stamp Settings button is displayed on
the right of this check box. You can choose this button to display the Plot Stamp dialog box to
set the parameters for the plot stamp.

Save changes to layout
This check box is selected to save the changes made using the Plot dialog box and apply them
to the layout selected to be plotted.

Drawing orientation Area
This area provides options that help you specify the orientation of the drawing on the paper for
the plotters that support landscape or portrait orientation. You can change the drawing orientation
by selecting the Portrait or Landscape radio button, with or without selecting the Plot
Upside-Down check box. The paper icon displayed on the right side of this area indicates the
media orientation of the selected paper and the letter icon (A) on it indicates the orientation of
the drawing on the page. The Landscape radio button is selected by default for AutoCAD LT
drawings and orients the length of the paper along the X axis, that is horizontally. If we assume
this orientation to be at a rotation angle of 0-degree, when selecting the Portrait radio button,
the plot is oriented with the width along the X axis, which is equivalent to the plot being rotated
through a rotation angle of 90-degree. Similarly, if you select both the Landscape radio button
and the Plot upside-down check box at the same time, the plot gets rotated through a rotation
angle of 180-degree and if you select both the Portrait radio button and the Plot upside-down
check box at the same time, the plot gets rotated through a rotation angle of 270-degree. The
AutoCAD LT screen conforms to the landscape orientation by default.

Preview
When you choose the Preview button, AutoCAD LT displays the drawing on the screen just as
it would be plotted on the paper. Once the regeneration is performed, the dialog boxes on the
screen are removed temporarily, and an outline of the paper size is shown. In the plot preview
(Figure 12-3), the cursor is replaced by the Zoom Realtime icon. This icon can be used to zoom
in and out interactively by holding the pick button down and then moving the pointing device.
You can right-click to display a shortcut menu and then choose Exit to exit the preview or press
the ENTER or ESC key to return to the dialog box. You can also choose Plot to plot the drawing
right away or choose the other zooming options available.

Tip
You can also choose File > Plot Preview from the menu bar to preview the plot, and at the
same time, bypass the Plot dialog box.
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Menu: File > Plotter Manager
Command: PLOTTERMANAGER

After finishing with all the settings and other parameters, if you choose the OK button in the
Plot dialog box, AutoCAD LT starts plotting the drawing in the file or plotters as specified.
AutoCAD LT displays the Plot Progress dialog box (Figure 12-4), where you can view the actual
progress in plotting.

ADDING PLOTTERS

In AutoCAD LT, the plotters can be added using the PLOTTERMANAGER command. This
command is discussed next.

Figure 12-3  Full plot preview with the shortcut menu

Figure 12-4  The Plot Progress dialog box
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PLOTTERMANAGER  Command
When you invoke the PLOTTERMANAGER command, AutoCAD LT will display the Plotters
window, see Figure 12-5.

The Plotters window is basically a Windows Explorer window. It displays all the configured
plotters and the Add-A-Plotter Wizard icon. You can right-click on any one of the icons belonging
to the plotters that have already been configured to display a shortcut menu. You can choose
Delete from the shortcut menu to remove a plotter from the list of available plotters in the
Name drop-down list in the Plot/Page Setup dialog box. You can also choose Rename from the
shortcut menu to rename the plotter configuration file or choose Properties to view the properties
of the configured device.

Add-A-Plotter Wizard
If you double-click on the Add-A-Plotter Wizard icon in the Plotters window, AutoCAD LT
guides you to configure a nonsystem plotter for plotting your drawing files. AutoCAD LT stores
all the information of a configured plotter in configured plot (PC3) files. The PC3 files are
stored in the Documents and Settings\<owner>\Application Data\Autodesk\AutoCAD LT
2006\R11\enu\Plotters folder by default. The steps for configuring a new plotter using the Add-A-
Plotter Wizard are as follows.

Figure 12-5  The Plotters window
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1. Open the Plotters window by choosing File > Plotter Manager from the menu bar and
double-click on the Add-A-Plotter Wizard icon.

2. In the Add Plotter wizard, carefully read the Introduction page, and then choose the Next
button to advance to the Add Plotter - Begin page.

3. On the Add Plotter - Begin page, the My Computer radio button is selected by default.
Choose the Next button. The Add Plotter - Plotter Model page is displayed.

4. On this page, select a manufacturer and model of your nonsystem plotter from the
Manufacturers and Models list boxes, respectively. Now, choose the Next button. The Add
Plotter - Import Pcp or Pc2 page is displayed.

If your plotter is not present in the list of available plotters, and you have a driver disk for
your plotter, choose the Have Disk button to locate the HIF file from the driver disk, and
install the driver supplied with your plotter.

5. In the Add Plotter - Import Pcp or Pc2 page, if you want to import configuring information
from a PCP or a PC2 file created with a previous version of AutoCAD LT, you can choose the
Import File button and select the file. Otherwise, simply choose the Next button to advance
to the next page.

6. On the Add Plotter - Ports page, select the port from the list to be used when plotting, and
choose Next.

7. On the Add Plotter - Plotter Name page, you can specify the name of the currently configured
plotter or the default name will be entered automatically. Choose Next.

8. When you reach the Add Plotter - Finish page, you can choose the Finish button to exit the
Add-A-Plotter Wizard.

You can also choose the Edit Plotter Configuration button to display the Plotter
Configuration Editor dialog box where you can edit the current plotter’s configuration.
Also, in this page you can choose the Calibrate Plotter button to display the Calibrate
Plotter wizard. This wizard allows you to calibrate your plotter by setting up a test measurement.
After test plotting, it compares the plot measurements with the actual measurements and
computes a correction factor.

Once you have chosen Finish to exit the wizard, a PC3 file for the newly configured plotter will
be displayed in the Plotters window. This PC3 file contains all the settings needed by the
plotter to plot. Also, the newly configured plotter name is added to the Name drop-down list in
the Plotter configuration area of the Plot Device tab in the Plot dialog box. You can now use the
plotter for plotting.
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EDITING PLOTTER CONFIGURATION
You can modify the properties of a selected plot device by using the Plotter Configuration
Editor dialog box. This dialog box can be invoked in several ways. As discussed earlier, when
using the Plot or Page Setup dialog box, you can choose the Properties button in the Printer/
plotter area to display the Plotter Configuration Editor dialog box, see Figure 12-6.

You can modify the default settings for a plotter while configuring it, by choosing the Edit
Plotter Configuration button on the Add Plotter - Finish page of the Add Plotters wizard. You
can also select the PC3 file for editing in the Plotters window using Windows Explorer (by
default, PC3 files are stored in the \Documents and Settings\<owner>\Application
Data\Autodesk\AutoCAD LT 2006\R11\enu\Plotters folder) and double-click on the file or right-click
on the file and choose Open from the shortcut menu. The three tabs in the Plotter Configuration
Editor are discussed next.

General tab
This tab contains basic information about the configured plotter or the PC3 file. You can make
changes only in the Description area. The rest of the information in the tab is read only. This
tab contains information on the configured plotter file name, plotter driver type, HDI driver file

Figure 12-6  The Plotter Configuration Editor dialog box
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version number, name of the system printer (if any), and the location and name of the PMP file
(if any calibration file is attached to the PC3 file).

Ports Tab
This tab contains information about the communication between the plotting device and your
computer. You can choose between a serial (local), parallel (local), or network port. The default
settings for parallel and serial ports are LPT1 and COM1, respectively. You can also change the
port name, if your device is connected to a different port. You can also select the Plot to File
radio button, if you want to save the plot as a file. You can select Autospool, if you want plotting
to occur automatically, while you continue to work on another application.

Device and Document Settings Tab
This tab contains the plotting options specific to the selected plotter, displayed as a tree view in
the window. For example, if you configure a nonsystem plotter, you have the option to modify
the pen characteristics. You can select any plotter properties from the tree view displayed in the
window to change the values as required. Whenever you select an icon from the tree view in the
window, the corresponding information is displayed in an area below. For example, if you select
PMP File Name <None> in the tree view in the window, a PMP file area is displayed below.
This area contains the current settings and options to modify it. Information that is displayed
within brackets (<>) can be modified. By default, Custom properties is displayed as highlighted
in the window because it contains the properties that are modified commonly. The Access
Custom Dialog area is displayed below the window. Choosing the Custom Properties button in
this area displays a dialog box specific to the selected plotter. This dialog box has several
properties of the selected plotter grouped and displayed under various areas and can be modified
here.

Once you have made the desired changes, choose OK to exit the dialog box and then choose
Save As in the Plotter Configuration Editor dialog box to save the changes you just made to the
PC3 file. You can also import old plot configuration files (PCP or PC2) from the previous
releases of AutoCAD LT using the Import button and save some of the information from these
settings as a new PC3 file. When you choose the Import button, the Plotting Components
dialog box is displayed. This  dialog box displays what to use to import AutoCAD LT 14
information into an AutoCAD LT 2006 drawing. For example, it tells you that to import PCP or
PC2 file setting into a drawing in AutoCAD LT 2006, you should use the Import PCP or PC2
Plot Settings Wizard. Choose OK to exit this dialog box;  the Import dialog box is displayed.
Here you can select the file to be imported and then choose the Import button.

Tip
It is better to create a new PC3 file for a plotter and keep the original file as it is so that you
encounter no error while using the specific printer later. The PC3 files determine the proper
function of a plotter and any modifications may lead to errors.
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IMPORTING PCP/PC2 CONFIGURATION FILES
If you want to import a PCP or PC2 configuration file or plot settings created by previous
releases of AutoCAD LT into the Model tab or the current layout for the drawing, you can also
use the PCINWIZARD command to display the Import PCP or PC2 Plot Settings Wizard. All
information from a PCP or PC2 file regarding plot area, rotation, plot offset, plot optimization,
plot to file, paper size, plot scale, and pen mapping can be imported. Read the Introduction
page of the wizard that is displayed carefully and then choose the Next button. The Browse File
Name page is displayed. Here, you can either enter the name of the PCP or PC2 file directly in
the PC2 or PCP file name edit box or then choose the Browse button to display the Import
dialog box, where you can select the file to be imported. After you specify the file for importing,
choose Import to return to the wizard. Choose the Next button to display the Finish page. After
importing the files, you can modify the rest of the plot settings for the current layout.

SETTING THE PLOT PARAMETERS
Before starting with the drawing, you can set various plotting parameters in the Model tab or in
the Layouts. The plot parameters that can be set include the plotter to be used, for example,
plot style table, the paper size, units, and so on. All these parameters can be set using the
PAGESETUP command discussed next.

Working with Page Setups

As discussed earlier, a page setup contains the settings required to plot a drawing.
Each layout, as well as the Model tab, can have a unique page setup attached to it. You
can use the PAGESETUP command to create named page setups that can be used later.

A page setup consists of specifications for the layout page, plotting device, paper size, and
settings for the layouts to be plotted. The PAGESETUP command can also be invoked from
the shortcut menu by right-clicking on the current Model or Layout tab and choosing Page
Setup Manager. Remember that the Page Setup Manager option will be available in the shortcut
menu only for the current Model or Layout tab.

When you invoke the PAGESETUP command, AutoCAD LT displays the Page Setup Manager
dialog box. The tabs displayed in the Current page setup list box of the Page setups area
depend on the tab in which you invoke this dialog box. For example, if you invoke this dialog
box from the Model tab, it displays only Model in this list box. However, if you invoke this
dialog box from the Layout tab, it displays the list of all the layouts that are invoked at least
once. Figure 12-7 shows the Page Setup Manager invoked from the Layout tab. In this case,
both Layout1 and Layout2 were activated at least once.

You can use this dialog box to create a new page setup, modify the existing page setup, or import
a page setup from an existing file.

Toolbar: Layouts > Page Setup Manager
Menu: File > Page Setup Manager
Command: PAGESETUP
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Creating a New Page Setup
To create a new page setup, choose the New button from the Page Setup Manager dialog box.
The New Page Setup dialog box will be displayed, as shown in Figure 12-8. Enter the name of
the new page setup in the New page setup name text box. The existing page setups with which
you can start are shown in the Start with area. You can select any of the page setups listed in this
area and choose OK to proceed.

Figure 12-7  The Page Setup Manager dialog box when displayed in the Layout tab

Figure 12-8  The New Page Setup dialog box
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When you choose OK, the Page Setup dialog box will be displayed. This dialog box is similar
to the Plot dialog box, see Figure 12-9.

Modifying a Page Setup
To modify a page setup, select the page setup from the Current page setup list box and choose
the Modify button. The Page Setup dialog box will be displayed. Modify the parameters in this
dialog box and exit it.

Note
If you select the Display when creating a new layout check box, the Page Setup Manager
will be displayed whenever you invoke a layout for the first time.

Importing a Page Setup

AutoCAD LT allows you to import a user-defined page setup from an existing drawing and use
it in the current drawing or base the current page setup for the drawing on it. This option is
available by choosing the Import button from the Page Setup Manager dialog box. It is also
possible to bypass this dialog box and directly import a page setup from an existing drawing
into a new drawing layout by using the PSETUPIN command. This command facilitates importing

Figure 12-9  The Page Setup dialog box

Command: PSETUPIN
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a saved and named page setup from a drawing into a new drawing. The settings of the named
page setup can be applied to layouts in the new drawing. When you choose the Import button
from the Page Setup Manager dialog box or  invoke the PSETUPIN command, the Select
Page Setup From File dialog box is displayed, as shown in Figure 12-10.  You can use this dialog
box to locate a .dwg, .dwt, or .dwf file whose page setups have to be imported. After you select the
file, AutoCAD LT displays the Import Page Setups dialog box, as shown in Figure 12-11. You
can also enter -PSETUPIN at the Command prompt to display prompts at the command line.

Note
If a page setup with the same name already exists in the current file, the AutoCAD LT Alert box
is displayed and you will be informed that “A page setup with the same name already exists in the
current file, do you want to redefine it?” If you choose Yes in this dialog box, the current page
setup will be redefined.

USING PLOT STYLES
The plot styles can change the complete look of a plotted drawing. You can use this feature to
override a drawing object’s color, linetype, and lineweight. For example, if an object is drawn on
a layer that is assigned the color red and no plot style is assigned to it, the object  will be plotted
as red. However, if you have assigned a plot style to the object with the color blue, the object will
be plotted as blue irrespective of the layer color it was drawn on. Similarly, you can change the
end, join, and fill styles of the drawing, and also change the output effects such as dithering,

Figure 12-10  The Select Page Setup From File dialog box
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gray scales, pen assignments, and screening. Basically, you can use Plot Styles effectively to plot
the same drawing in various ways.

Every object and layer in the drawing has a plot style property. The plot style characteristics are
defined in the plot style tables attached to the Model tab, layouts, and viewports within the
layouts. You can attach and detach different plot style tables to get different looks for your plots.
Generally, there are two plot style modes. They are Color-Dependent and Named. The
Color-dependent plot styles are based on object color and there are 255 color-dependent plot
styles. It is possible to assign each color in the plot style a value for the different plotting
properties and these settings are then saved in a color-dependent plot style table file that has a
.ctb extension. Similarly, Named plot styles are independent of the object color and you can
assign any plot style to any object regardless of that object’s color. These settings are saved in a
named plot style table file that has .stb extension. Every drawing in AutoCAD LT 2006 is in
either of the plot style modes.

Adding a Plot Style

All plot styles are saved in the \Application Data\Autodesk\AutoCAD LT 2006\R11\enu\Plot Styles
folder. If you enter STYLESMANAGER at the Command prompt, AutoCAD LT displays the

Figure 12-11  The Import Page Setup dialog box

Menu: File > Plot Style Manager
Command: STYLESMANAGER
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Plot Styles Manager window, see Figure 12-12. This window displays icons for all the available
plot styles, in addition to the Add-A-Plot Style Table Wizard icon. You can double-click on any
of the plot style icons to display the Plot Style Table Editor dialog box and edit the selected
plot style. When you double-click on the Add-A-Plot Style Table Wizard icon, the Add Plot
Style Table wizard is displayed and you can use it to create a new plot style.

Add-A-Plot Style Table Wizard
If you want to add a new plot style table to your drawing, double-click on the Add-A-Plot Style
Table Wizard in the Plot Styles Manager window to display the Add Plot Style Table wizard.
You can also invoke the wizard by choosing Tools > Wizards > Add Plot Style Table from the
menu bar. The following are the steps for creating a new plot style table using the wizard.

1. Read the introduction page carefully and choose the Next button.

2. In the Begin page, select the Start from scratch radio button and choose Next. Selecting
this option creates a new plot style table. Therefore, the Browse File page is not available.

In addition to the Start from scratch option, this page has three more options. They are
Use an existing plot style table, Use My R14 Plotter Configuration (CFG), and Use a
PCP or PC2 file. When you use the Use an existing plot style table option, an existing

Figure 12-12  The Plot Styles window
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plot style table is used as a base for the new plot style table you are creating. In such a
situation, the Table Type page of the wizard is not available and is not displayed because the
table type will be based on the existing plot style table you are using to create a new one.
With the Use My R14 Plotter Configuration (CFG) option, the pen assignments from the
acad2006.cfg file are used as a base for the new table you are creating. If you are using the
Use a PCP or PC2 option, the pen assignments saved earlier in a Release 14 PCP or PC2
file are used to create the new plot style.

3. In the Pick Plot Style Table page, select the Named Plot Style Table or the Color-Dependent
Plot Style Table according to your requirement. Select the Color-Dependent Plot Style
Table radio button and then choose the Next button.

4. Since you have selected the Start from scratch radio button in the Begin page, the Browse
File page is not available and the File name page is displayed. However, if you had selected
any of the other three options on the Begin page, the Browse File page would have been
displayed. You can select an existing file from the drop-down list available in this page or
choose the Browse button to display the Select File dialog box. You can then browse and
select a file from a specific folder and choose Select to return to the wizard. You can also
enter the name of the existing plot style table on which you want to base the new plot style
table, directly in the edit box. After you have specified the file name, choose Next to display
the File name page of the wizard. In the File name page, enter a file name for the new plot
style table and choose Next. The Finish page is displayed.

Note
If you are using the pen assignments from the Release 14 acad.cfg file to define the new plot style
table, you also have to specify the printer or plotter to use from the drop-down list available in the
Browse File page of the wizard.

5. The Finish page gives you the option of choosing the Plot Style Table Editor button to
display the Plot Style Table Editor and then edit the plot style table you have created. If you
select the Use this plot style table for new and pre-AutoCAD LT 2004 drawings check box
in this page of the wizard, the plot style table that you have created will become the default
plot style table for all the drawings you create. This check box is available only if the plot
style mode you have selected in the wizard is the same as that you have specified as the
default plot style mode in the Default plot style behavior for new drawings area in the
Plotting tab of the Options dialog box. Choose Finish in the Finish page of the wizard to
exit the wizard. A new plot style table gets added to the Plot Styles window and can be used
for plotting.

Note
You can also choose Add Named Plot Style Table/ Add Color-Dependent Plot Style Table
from the Tools > Wizards menu to display wizards that are similar to the Add Plot Style Table
wizard except that in the Begin page, the Use an existing plot style table option is not available.
Also the Table Type page is not there and the Finish page has an additional option to use the new
plot style table for the current drawing.
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Plot Style Table Editor
When you double-click on any of the plot style table icons in the Plot Styles window, the Plot
Style Table Editor is displayed, where you can edit the particular plot style table. You can also
choose the Plot Style Table Editor button in the Finish page to display the Plot Style Table
Editor and choose the Edit button adjacent to the Name drop-down list in the Plot style table
(pen assignments) area in the Plot Device tab of the Plot or Page Setup dialog box to display
the Plot Style Table Editor.

The Plot Style Table Editor has three tabs: General, Table View, and Form View. You can edit
all the properties of an existing plot style table using the different tabs. The description of the
tabs are as follows.

General Tab
This tab provides information about the file name, location of the file, version, and scale factor.
All information except the description is read only. You can enter a description about the plot
style table in the Description text box here. If you select the Apply global scale factor to
non-ISO linetypes check box, all the non-ISO linetypes in a drawing are scaled by the scale
factor specified in the Scale factor edit box below the check box. If this check box is cleared (by
default), the Scale factor edit box is not available.

Table View Tab
This tab displays all the plot styles, available with their properties in tabular form, that can be
edited individually here, see Figure 12-13.

In the case of a named plot style table, you can edit the existing styles or add new styles by
choosing the Add Styles button. A new column with the default style name Style1 will be added
in the table. You can change the style name if you want. You can edit the various properties in the
table by selecting a particular value you want to modify and a corresponding drop-down list is
displayed. You can select a value from this drop-down list. This manner of editing is similar to
the one we use when editing properties of objects using the PROPERTIES palette. The Normal
plot style table is not available and therefore cannot be edited. This plot style is assigned to
layers by default.

You can select a particular plot style by clicking on the gray bar above the column and the entire
column gets highlighted. You can select several plot styles by pressing the SHIFT key and
selecting more plot styles. All the plot styles that are selected are highlighted. If you choose the
Delete Style button now, the selected plot styles are removed from the table.

Choosing the Edit Lineweights button displays the Edit Lineweights dialog box. You can
select the units for specifying the lineweights in the Units for listing area of the dialog box, and
can use either Millimeters or Inches. You can also edit the value of a lineweight by selecting it
in the Lineweights list box and choosing the Edit Lineweight button. After you have edited
the lineweights, choose the Sort Lineweights button to rearrange the lineweight values in the
list box. Choose OK to exit the dialog box and return to Plot Style Table Editor.
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With a color-dependent plot style table, the Table View tab displays all 255 plot styles, one for
each color, and the properties can be edited in the table in the same way as discussed for named
plot styles. The only difference is that you cannot add a new plot style or delete an existing one,
and therefore, the Delete Style and Add Style buttons are not available. The properties that can
be defined in a plot style are discussed next.

Name. This field displays the name of the color in the case of the color-dependent plot styles
and the name of the style in the case of the named plot styles.

Description. Here you can enter the description about the plot style.

Color. The color you assign to the plot style overrides the color of the object in the drawing. The
default value is Use object color.

Enable dithering. Dithering is described as a mixing of various colored dots to produce a new
color. You can enable or disable this property by selecting from the drop-down list that is
available in this field. Dithering is enabled by default and is independent of the color selected.

Figure 12-13  The Plot Style Table Editor (Table View tab)
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Convert to grayscale. If you are using a plotter that supports grayscaling, selecting On from
the drop-down list in this field applies a grayscale to the objects color. By default, Off is selected
and the object’s color is used.
Use assigned pen #. This property is applied only to pen plotters. The pens range from 1 to
32. The default value is Automatic, which implies that the pen used will be based on the plotter
configuration.
Virtual pen #. Nonpen plotters can behave like pen plotters using virtual pens. The value of
this property lies between 1 and 255. The default value is Automatic. This implies that AutoCAD LT
will assign a virtual pen automatically from the AutoCAD LT Color Index (ACI).

Screening. This property of a plot style indicates the amount of ink used while plotting. The
value ranges between 0 and 100. The default value is 100, which creates the plot in its full
intensity. Similarly, a value of 0 produces white color. This may be useful when plotting on a
colored background.

Linetype. Like the property of color, the linetype assigned to a plotstyle overrides the object
linetype on plotting. The default value is Use object linetype.

Adaptive adjustment. This property is applied by default and implies that the linetype scale
of a linetype is applied such that on plotting, the linetype pattern will be completed.

Lineweight. The lineweight value assigned here overrides the value of the object lineweight on
plotting. The default value is Use object lineweight.

Line End Style. This determines the manner in which a plotted line ends. The effect of this
property is more noticeable when the thickness of the line is substantial. The line can end in a
Butt, Square, Round, or Diamond shape. The default value is Use object end style.

Line Join Style. You can select the manner in which two lines join in a plotted drawing. The
available options are Miter, Bevel, Round, and Diamond. The default value is Use object join
style.

Fill Style. The fill style assigned to a plot style overrides the objects fill style, when plotted. The
available options are Solid, Checkerboard, Crosshatch, Diamonds, Horizontal Bars, Slant
Left, Slant Right, Square Dots, and Vertical Bars.

Form View Tab
This tab displays all the properties in one form, see Figure 12-14. All the available plot styles are
displayed in the Plot Styles list box. You can select any style in the list box and then edit its
properties in the Properties area.

While creating a named plot styles table (.stb), if you want to add a new plot style, choose the
Add Style button and AutoCAD LT will display the Add Plot Style dialog box with the default
plot style name Style 1. You can change the name of the plot style in the Plot Style edit box, see
Figure 12-15. Now, when you choose the OK button, the new style will be added in the Plot
Styles list box and you can select it for editing. If you want to delete a style, select it and then
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choose the Delete Style button. With a color-dependent plot styles the Form View tab also does
not provide options that allow you to add or delete plot styles.

After editing, choose the Save & Close button to save and return to the Plot Styles window. You
can also choose the Save As button to display the Save As dialog box and save a plot style table
with another name. To remove the changes you made to a plot style table, choose the Cancel
button.

Figure 12-14  The Plot Style Table Editor (Form View tab)

Figure 12-15  The Add Plot Style dialog box
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Applying Plot Styles
The Model, or any of the layout tabs, can be assigned a plot style table. The plot style table can
be either named or color-dependent, as discussed earlier. These plot style modes for a new
drawing can be determined in the Default plot style behavior for new drawings area of the
Plotting tab of the Options dialog box. The Use color dependent plot styles option is selected
by default and the drawings are assigned a color-dependent plot style. If you select the Use
named plot styles radio button, the new drawings (not the current drawing) will be assigned a
named plot style. The PSTYLEPOLICY system variable also controls the default plot style
modes of the new drawings. A value of 0 implies a named plot style mode and a value of 1
implies a color-dependent plot style mode.

You can select a plot style table that you want to use as a default for the drawings from the Default
plot style table drop-down list in the Default plot style behavior for new drawings area of the
Plotting tab of the Options dialog box. If you select None, the drawing is plotted with the object
properties as displayed on the screen. In this area of the Options dialog box, only when you
select the Use named plot styles radio button, are the Default plot style for layer 0 and the
Default plot style for objects drop-down lists available. You can select the default plot styles that
you want to assign to Layer 0 and to the objects in a drawing from these drop-down lists,
respectively. If you choose the Add or Edit Plot Style Table button in this area of the Plotting
tab of the Options dialog box, the Plot Styles window is displayed. Here, you can double-click
on any plot style table icon available and edit it using the Plot Style Table Editor that is
displayed.

To change the plot style table for a current layout, you have to invoke the Page Setup or Plot
dialog box and then select a plot style table from the Name drop-down list in the Plot style
table (pen assignments) area of the Plot Device tab of the dialog box. A color-dependent plot
style table can be selected and applied to a tab only if the default plot style mode already has
been set to color dependent. Similarly, if you want to apply a named plot style table to a tab, the
Use named plot styles radio button should have been selected in the Plotting tab of the Options
dialog box.

A color-dependent plot style cannot be applied to objects or layers and therefore the Plot Style
Control drop-down list in the Properties toolbar is not available when a drawing has a
color-dependent plot style mode. The plot styles also appear grayed out in the
Layer Properties Manager dialog box and cannot be selected and changed. However, named
plot styles can be applied to objects and layers. A plot style applied to an object overrides the
plot style applied to the layer on which the object is drawn. To apply a plot style to a layer,
invoke the Layer Properties Manager dialog box where all the layers in the selected tab are
displayed. Select a layer to which you want to apply a plot style and select the default plot style
(Normal) currently applied to the layer. The Select Plot Style dialog box is displayed, see
Figure 12-16. The Plot styles list box in this dialog box displays all the plot styles present in the
plot style table attached to the current tab. You can select another plot style table to attach to the
current tab from the Active plot style table drop-down list. You will notice that all the plot styles
in the selected plot style table are displayed in the list box now. You can also choose the Editor
button to display the Plot Style Table Editor to edit plot style tables, as discussed earlier. The
Select Plot Style dialog box also displays the name of the original plot style assigned to the
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object adjacent to Original. Also, the new plot style to
be assigned to the selected object is displayed next to
New.

You can apply a named plot style to an object using the
Plot Style Control drop-down list in the Properties
toolbar or the Properties palette. The process is the same
as that applied for layers, colors, linetypes, and
lineweights. This named plot style is applied to an
object irrespective of the tab on which it is drawn. If the
plot style assigned to an object is present in the plot
style table of the tab in which it is present, the object is
plotted with the specified plot style. However, if the plot
style assigned to the object is not present in the plot
style table assigned to the tab on which it is drawn, the
object will be plotted with the properties that are
displayed on the screen. The default plot style assigned
to an object is Normal and the default plot style assigned
to a layer is ByLayer.

Setting the Current Plot Style
You can use the PLOTSTYLE command to set the current
plot style for new objects or of selected object. When you
enter PLOTSTYLE at the Command prompt, and if no object has been selected in the drawing,
AutoCAD LT displays the Current Plot Style dialog box, see Figure 12-17. However, if any
object selection is there in the drawing, then AutoCAD LT displays the Select Plot Style dialog
box (Figure 12-16), which has been discussed earlier. You canselect a plot style from the list box
and choose OK to assign it to the selected objects in the drawing. All the plot styles present in
the current plot style table that are assigned to the current tab are displayed in the list box in the
Current Plot Style dialog box. You can select any one of these plot styles and choose OK. Now,
when you create new objects, they will have the plot style that you had set current in the Current
Plot Style dialog box. The parameters of this dialog box are described next.

Current plot style
The name of the current plot style is displayed adjacent to this label.

Plot style list box
This list box lists all the available plot styles that can be assigned to an object, including the
default plot style, Normal.

Active plot style table
This drop-down list displays the names of all the available plot style tables. The current plot
style table attached to the current layout or viewport is displayed in the edit box.

Figure 12-16  The Select Plot Style
dialog box



12-28                                                                                            AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Editor
If you choose the Editor button, adjacent to the drop-down list, AutoCAD LT displays the Plot
Style Table Editor to edit the selected plot style table.

Attached to
The tab to which the selected plot style table is attached, Model or any one of the layout tabs, is
displayed next to this label.

Note
As soon as the drawing is plotted Plot/Publish Details Report Available button is displayed in
the status bar tray. Choose this button to see the plot and publish details. This option has been
discussed in Chapter 1.

Create the drawing shown in Figure 12-18. Create a named plot style table My Named Table.stb
with three plot styles: Style 1, Style 2, and Style 3, in addition to the Normal plot style. The
Normal plot style is used for plotting the object lines. These three styles have the following
specifications.

Style 1. This style has a value of Screening = 50. The dimensions, dimension lines, and the
text in the drawing must be plotted with this style.

Style 2. This style has a value of Lineweight = 0.800. The border and title block must be
plotted with this style.

Figure 12-17  The Current Plot Style dialog box

Exercise 1 Mechanical



Plotting Drawings      12-29

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Style 3. This style has a linetype of Medium Dash. The centerlines must be plotted with this
plot style.

Answer the following questions, and then compare your answers to those given at the end of
this chapter.

1. All the settings about a plotter are saved in the .PC3 file. (T/F)

2. Different objects in the same drawing can be plotted in different colors, with different
linetypes and line widths. (T/F)

3. You can partially or fully preview a drawing before plotting. (T/F)

4. The PSLTSCALE system variable controls the paper space linetype scaling and has a default
value of 1. (T/F)

5. The size of a plot can be specified by selecting any paper size from the __________ drop-down
list in the Plot dialog box.

6. If you want to store the plot in a file and not have it printed directly on a plotter, select the
__________ check box in the Printer/plotter area.

7. The scale for the plot can also be specified in the __________ edit boxes in the Plot dialog
box.

Figure 12-18  Drawing for Exercise 1

Self-Evaluation Test
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8. If you select the __________ option from the What to plot drop-down list, the portion of
the drawing that is in the current display is plotted.

9. If ___________ checkbox is selected, AutoCAD LT automatically centers the plot on the
paper  by calculating the X and Y offset values.

10. You can set the quality of the plot using the __________ drop-down list in the Shaded
viewport options area.

Answer the following questions.

1. The Page Setup Manager dialog box is displayed when you invoke the PAGESETUP
command. (T/F)

2. By selecting the View option in the Plot area from the What to plot drop-down list, you can
plot a view that was created with the VIEW command in the current drawing. (T/F)

3. If you select Hide paperspace objects checkbox, the objects drawn in paperspace will be
hidden while plotting (T/F)

4. The orientation of the drawing can be changed using the Plot dialog box. (T/F)

5. Which check box in the Plot options area of the Plot dialog box is available only if you are
plotting in a layout tab?

(a) Plot paperspace last (b) Hide objects
(c) Plot with plot styles (d) None

6. Which command when invoked displays the Plotters window?
(a) PLOTTER (b) PLOTTERMANAGER
(c) PLOTSTYLE (d) None

7. With which command is it possible to bypass the Plot/Page Setup dialog box and directly
import a page setup from an existing drawing into a new drawing layout?

(a) PSETUPIN (b) PLOTTERMANAGER
(c) PLOTSTYLE (d) None

8. Which command is used to create a new plot style?

(a) STYLE (b) STYLESMANAGER
(c) PLOTSTYLE (d) None

Review Questions
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9. Which command can be used to import a PCP file or PC2 files?

(a) PCINWIZARD (b) PCIN
(c) PLOTSTYLE (d) None

10. You can view the plot on the specified paper size before actually plotting it by selecting the
__________ button in the Plot dialog box.

11. In the preview window in the Printer/plotter area, the __________ rectangle is the section
of the paper that is used by the image.

12. You can modify the properties of a selected plotting device by using the __________.

13. The plot style modes available are __________ and __________.

14. The Plot Style Table Editor has three tabs: __________ , __________ , and __________.



12-32                                                                                            AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Figure 12-19  Drawing for Exercise 2

Create the drawing shown in Figure 12-19 and plot it according to the following specifications.
Create and use a plot style table with the specified plot styles.

1. The drawing is to be plotted on 10 X 8 inch paper.

2. The object lines must be plotted with a plot style Style 1. Style 1 must have a value of
lineweight = 0.800 mm.

3. The dimension lines must be plotted with plot style Style 2. Style 2 must have a value of
screening = 50.

4. The centerlines must be plotted with plot style Style 3. Style 3 must have a linetype of
Medium Dash and screening = 50.

5. The border and title block must be plotted with plot style Style 4. The value of the
lineweight =0.25 mm.

Exercises

Exercise 2 Mechanical
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Figure 12-20  Drawing for Exercise 3

Problem Solving Exercise 1 Mechanical

Create the drawing shown in Figure 12-20 and plot the drawing according to your specifications.

Make the drawing shown in Figure 12-21 and plot it according to your specifications.

Exercise 3 Mechanical



12-34                                                                                            AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Figure 12-21  Drawing for Problem Solving Exercise 1

Answers to Self-Evaluation Test
1 - T, 2 - T, 3 - F, 4 - T, 5 - Paper size, 6 - Plot to file, 7 - Custom, 8 - Display, 9 - Center the plot,
10 - Quality


